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CIRRUS LOGIC CDB43131K

CDB43131K Kit Manual

Features

e Configurable serial audio headers for PCM, DSD and DoP audio
e Headphone and line outputs

e Analog and S/PDIF audio input

e USB audio module capability

e WISCE™ I?C-based software control

o Windows® compatible

Description

The CDB43131K is a dedicated platform for testing and evaluating the CS43131. The CS43131 is a high-performance
audio DAC with integrated impedance detection and headphone drivers. To allow comprehensive testing and evaluation
of the performance of the CS43131, extensive software-configurable options are available through the CDB43131
evaluation kit. The kit also included the CDB-HDR-MEAS, for measuring the 130 dB dynamic range performance of the
CS43131.

Software options, such as register settings for the CS43131, are configured via the WISCE software tool, which
communicates with the CDB43131K via an Aardvark I2C/SPI host adapter from a Windows computer, or via Mini-USB
cable.
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Figure 1 CDB43131 Board Block Diagram
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1 CDB43131K Kit Overview

The CDB43131K kit consists of an evaluation board, a high dynamic range (HDR) measurement board, and a USB cable.
Each of these component boards is described in the following sections.

1.1 CDB43131 Board
The CDB43131 is shown in the following figure.

CIRRUS LOGIC'
* CDB43131°

Figure 2 CDB43131 Base Board

1.2 CDB-HDR-MEAS Board

The CDB-HDR-MEAS is shown in the following figure. This board is used for measuring the very low HDR of the device
with an Audio Precision SYS-2700 or APx555 audio analyzer.

Figure 3 CDB-HDR-MEAS Board

DS1155v2DB2 Cirrus Logic Confidential 3
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2 CDB43131 Board Overview

The CDB43131 is the board for evaluating the performance of the CS43131. It supports multiple power supplies and
signal 1/0 configurations.

The CDB43131 board uses five buffers with direction control to direct clock from the digital input sources to/from the
CS43131 DUTs. Two buffers, the PCM/DoP buffer and the DSD/DoP buffer, support voltage translation from 3.3 V to 1.8
V and vice versa. The voltage selection is done through headers: J28 for the PCM/DoP buffer and the DSD/DoP buffer.
The S/PDIF buffer is a unidirectional buffer and supports 3.3 V to 1.8 V translation. The remaining buffers only support 1.8
V signals. These buffers are controlled by an I/O Expander. The I/O Expander can be controlled through its 1C interface.
The register map for 1/0O Expander is described in Section 3. The direction of clock signals is determined by the
CS43131’s operating mode (master or slave mode).

The CDB43131 can also communicate with a smart codec through the use of J42. The purpose of using a smart codec is
to allow the user to perform listening tests with various equalizer (EQ) filters based on the impedance of the attached
headphone. The CDB43131 board allows the PCM input to be routed to the smart codec. The codec can then apply an
EQ filter on this data, based on the impedance of the attached headphone and send EQ-filtered data to the CS43131, for
an optimal listening experience. The following diagram shows an overview of the CDB43131 board.
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Figure 4 CDB43131 Block Diagram
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2.1 Power Supply Circuitry

The CDB43131 board is powered from a 5-volt, 1.2-amp AC adapter or via the +5-volt bus from the USB connector. All
the supply rails for both the smart codec and the CS43131s are generated using a combination of switched-mode power
supplies (switchers) and LDOs. In addition to these internal supplies, the CDB43131 board also provides the option of
powering the CS43131 supply rails from external bench supplies via banana jacks.

The switchers and LDOs step down the +5 V supply to 3.6 V, 3.3V, 1.0 V, 1.8 V (analog), and 1.8 V (digital) levels.

If the device is set into External VCP_FILT Supply Mode and bypass the internal Class-H charge pump circuit, then a +3-
volt supply must be applied to VCP_FILT+ and VCP_FILT-. The banana jacks are connected to each device through a set
of resistors (R24/R25 for the CSP device, and R40/R41 for the QFN device). These resistors are unpopulated by default
and will need to be populated with a 0-Q resistor to connect the jack to the DUT.
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Figure 5 CDB43131 Power Supplies
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2.2 Digital Audio Input

221

Serial Audio I/O Headers

Headers J25 and J26, labeled ASP and XSP respectively, provide an interface for serial audio clocks and data. The
source of the clocks and data can be an external audio source such as a Audio Precision audio analyzer. The header
signals are described in the table below. The logic level on these pins is selectable by jumping J28 to 3.3 V or 1.8V.

Table 1 Serial Audio Header Pinout

Reference Designator Pins Pin Designation Direction Description
J25 7 MCLK 1/0 Master clock
5 SCLK 1/0 Bit clock
3 LRCLK 1/0 Frame clock
1 RXDAT Input Serial data
2,4,6,8 Ground Ground reference Board ground
J26 7 MCLK 1/0 Master clock
5 SCLK I/0 Bit clock
3 LRCLK I/0 Frame clock
1 RXDAT Input Serial data
2,4,6,8 Ground Ground reference Board ground

Audio signals to/from these headers are routed to/from the CS43131 using voltage-level translation buffers. The direction
of clock and data through these buffers is controlled using on-board TCA6424 I/O Expander IC. U9, U12, and U15
translate the signals on J25 and J26 from a voltage of 3.3 V or 1.8 V to the operational voltage of 1.8 V. The ASP signals
are then fed into J24, while the XSP signals are fed into J44. These 3x3 pin headers are for passing the 12S data from the
CS8422 S/PDIF transceiver to the DUTS.

To avoid the latency caused by buffers for higher clock frequencies like 352.8 kHz or 384 kHz, the user can connect the
external audio source directly to pins on headers J24 and J44. The pinouts for headers J24 and J44 are shown in the

following tables.

Table 2 Pinouts for Header J24

Pin #

Signal

1

SCLK1 from Buffer

SCLK1 to DAC

LRCLK1 from Buffer

LRCLK1 to DAC

SDIN1 from Buffer

SDIN1 to DAC

I CIREAEN Y

Ground

Table 3 Pinouts for Header J44

Pin #

Signal

SCLK?2 from Buffer

SCLK2 to DAC

LRCLK2 from Buffer

LRCLK2 to DAC

SDIN2 from Buffer

SDINZ2 to DAC

I EIREAEN Y

Ground

Cirrus Logic Confidential DS1155v2DB2
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CIRRUS LOGIC’ CDB43131K

To source the signals from the output of the buffers to the DAC, place jumpers between the two columns of pins labeled
BRD and DUT. For example, in order to send SCLK1, LRCLK1 and SDIN1 signals from the buffer to the DAC, place
jumpers between pins of the BRD and DUT group as shown in the following figure.

J24

son Il @ | @

trek! | @ @

scik1 | @@
258

J44

pspa/sonz [l @ @

DsoB/LRcK2 | @) @ @

pspcLk/scik2 | @) @ @
GND

BRD
DuT
GND

Figure 6 Jumper Settings to Route Signals from Buffers to DUT
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To source the signals from external audio source like a Audio Precision APx555, connect the cable that fits onto a 2-pin
header onto the pins labeled DUT and GND. For example, in order to send SCLK1, LRCLK1 and SDIN1 signals from a
APx to the DAC, connect the BITCLK output from the APx to the SCLK1 pins in the AP group, Frame CLK output from the
APx to LRCLK1 pins in the AP group, and the RXDAT1 output from the APx to SDIN1 pins in the AP group as shown in
the following figure.

e | @@ @

GND
J44
pspa/soN2 A | @ | @
DspB/LRCK2 | @) (@ | @
pspcLk/sck2 | @ | @ (@
g 'é g GND

Figure 7 External Audio Source to DUT

2.2.2 S/PDIF Receiver

The CS8422 S/PDIF receiver provides two-channel digital input either from an optical or coax connector. The CS8422 can
support sample rates up to 211 kHz and data output with either 16-, 18-, 20-, or 24-bit word lengths. Make sure that only
one source, either S/PDIF or coax, is used at one time to provide the input. The CS8422 is configured to operate in
Hardware Mode.

8 Cirrus Logic Confidential DS1155v2DB2
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2.3 Analog Audio Input

The CDB43131 features a 1/8" headphone jack for each the CSP (J16) and QFN (J34). Situated next to each headphone
jack are a pair of testpoints (J18/J19 and J35/J36, respectively) for connecting to an APX.

Ji9 R20
| @| =" 416

neina| I K HEESs

weine D [ EE =
ono| @] wa

R21

Figure 8 1/8" Headphone Jack and APx connectors for CSP
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Figure 9 1/8" Headphone Jack and APx connectors for QFN
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2.4 Analog Audio Output

The CDB43131 board has one 1/8" stereo headphone output jack (J1) for the CSP and one XLR cable output jack (J60)
for the QFN.

2 R EHE REF

JII6° »53g7 = |@ M

6| @ @ |32 mIm R4 GND J2
s & woura |k H W '

J4 HpouTelY [l
6|l @ @]:2|@

R3mm :::
s J6 2
J4 (I ] 600 > RI
R2
Figure 10 1/8" Headphone Jack/APx Connectors/Loading Jumpers for CSP
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e
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Figure 11 XLR Output/APx Connectors/Loading Jumpers for QFN

2.5 I2C Control

Header J42 (labeled I°C/SPI) provides an interface to connect a Total Phase Aardvark I1>C/SPI Host Adapter. The header
signals are described in the following table. The logic level on these pins is 3.3 V. Through this header, a user can
communicate with a smart codec, the TCA6424 1/O Expander, and the CS43131.

Table 4 12C/SPI Header Pinout

Header Pins Designation Description
J42 1 I2C_SCL 1°C clock

3 I2C_SDA I2C data
5 SPI_MISO SPI master in slave out
7 SPI SCLK SPI clock
9 SPI_SS SPI chip select
8 SPI_MOSI SPI master out slave in

2,10 GND Ground reference

4,6 NC No connect

10 Cirrus Logic Confidential DS1155v2DB2
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2.6 LEDs

The status LEDs on the CDB43131 board show the status of the power rails and S/PDIF input. A summary of the LEDs is

shown in the table below.

Table 5 Status LEDs

LED Function LED Reference LED Color Description
INT_QFN D1 Orange Interrupt from QFN
OFF No Interrupt
+3.6VP D2 Green Presence of +3.6 V rail
VP D7 Orange Interrupt from CSP
OFF No Interrupt
+5V D20 Green Presence of the +5 V rail
+3.3V D21 Green Presence of the +3.3 V rail
+1.8VD D22 Green Presence of the +1.8 VD rail
+1.8VA D23 Green Presence of the +1.8 VA rail
+1.0V D24 Off Presence of the +1.0 V rail
DS1155v2DB2 Cirrus Logic Confidential 11
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2.7 List of Headers and Jumper Settings

The following table lists all the available headers, jacks, and plugs on CDB43131 board.

Table 6 Header and Jumper Settings

Reference Connection Type 1/0 Description
Designator
Jl CSP-HPOUT 3.5-mm O | The headphone out jack for the CS43131 CSP device
headphone jack
J2 CSP-HPOUT- 2x1 header — | This header is for tying HPREF(A/B) to GND
REF
J4 CSP-HPOUTB 3x1x1 header — | Selectable loading resistance of 16/32/600 Q for CSP-HPOUTA
Loading
J5 CSP-HPOUTA 2x1 header O | 2-pin test point for Audio Precision
Test Point
J6 CSP-HPOUTB 2x1 header O | 2-pin test point for Audio Precision
Test Point
J7 QFN-GND-REF- 2x2 header — | Jumper between 1-3 and 2-4 to make outputs differential. Jumper between 1-
SEL 2 and 3-4 to make outputs single ended
J8 QFN-HPOUTA 2x1 header O | 2-pin test point for Audio Precision
Test Point
J9 QFN-HPOUTB 2x1 header O | 2-pin test point for Audio Precision
Test Point
J10 Optical S/PDIF Optical | Optical connector for S/PDIF Signals
IN connector
J11 Coaxial S/PDIF | RCA connector I Coaxial connector for S/PDIF Signals
IN
J12 VCP Source 3x1 header — | Jumper between 1-2 to get VCP from 1.8 V banana jack (J27). Jumper
Select between 2-3 to get VCP from 1.8 VA LDO
J13 VP Banana Jack Banana jack | External source for 3.6 VP
J15 CSP-HPOUTA 3x1x1 header — | Selectable loading resistance of 16/32/600 Q for CSP-HPOUTA
Loading
J16 CSP-HPIN 3.5mm | The headphone-in jack for the CS43131 CSP device
headphone jack
Ji7 QFN-HPOUTA 3x1x1 header — | Selectable loading resistance of 16/32/600 Q for QFN-HPOUTA
Loading
J18 CSP-HPINB 2x1 header O | 2-pin test point for Audio Precision
Test Point
J19 CSP-HPINA 2x1 header O | 2-pin test point for Audio Precision
Test Point
J20 GND Banana Banana jack I GND
Jack
J21 (Rev B USB Data Select 3x1 header — | IfENABLE is selected, the CDB will use the USB connection for data and
Only) power. If DISABLE is selected, the CDB will use the USB connection for
power only.
J22 VCP_FILT+ Banana jack | External source for VCP_FILT+
Banana Jack
J23 VCP_FILT- Banana jack | External source for VCP_FILT-
Banana Jack
J24 ASP DUT 3x3 header — | Connect shunt between (DUT-BRD) to connect DUT and ASP data.
Connection Disconnect shunt and use 2-pin test point for Audio Precision between (DUT-
GND) to measure ASP data directly
J25 ASP DATA 2x4 header 1/0 | Header for MCLK1/LRCLK1/SCLK1/RX Datal
J26 XSP DATA 2x4 header 1/0 | Header for MCLK2/LRCLK2/SCLK2/RX Data2
J27 1.8V Banana Banana jack | External Source for +1.8 V
Jack
J28 ASP/XSP VL 3x1 header — | Shunt between pins 1-2 for ASP/XSP to be translated to 3.3 V. Shunt
between pins 2-3 for ASP/XSP to be translated to 1.8 V
J31 QFN-HPOUTB 3x1x1 header — | Selectable loading resistance of 16/32/600 Q for QFN-HPOUTB
Loading
J34 QFN-HPIN 3.5mm I | The headphone-in jack for the CS43131 QFN device
headphone jack
12 Cirrus Logic Confidential DS1155v2DB2
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Reference Connection Type 110 Description
Designator
J35 QFN-HPINB 2x1 header O | 2-pin test point for Audio Precision
Test Point
J36 QFN-HPINA 2x1 header O | 2-pin test point for Audio Precision
Test Point
J40 VP Source 3x1 header — | Jumper between 1-2 to get VP from VP banana jack (J13). Jumper between
Select 2-3 to get VP from 3.6-V LDO
J41 VA Source 3x1 header — | Jumper between 1-2 to get VA from 1.8 V banana jack (J27). Jumper
Select between 2-3 to get VA from 1.8 VA LDO
J42 Aardvark 12C 5x2 header I/0 | Interface connector for Aardvark 12C test module
Interface (shrouded)
J43 USB Connector Mini-USB /0 | Provides USB Data and +5 V power to the CDB
receptacle
J44 XSP DUT 3x3 header — | Connect shunt between (DUT-BRD) to connect DUT and XSP data.
Connection Disconnect shunt and use 2-pin test point for Audio Precision between (DUT-
GND) to measure XSP data directly
J45 XMOS 10x2 right- 1/0 | Connects to XMOS programmer
Connector angle
connector
J46-J50 GND Testpoint GND testpoint O | GND Testpoint
J51 External 5V 2.5mm PIN I Provides external +5 V if USB VBUS is not used
Supply receptacle
J52 V5 Source 3x1 header — | Jumper between 1-2 to get 5 V from external supply (J52). Jumper between
Select 2-3to get 4V from USB VBUS (J43)
J53 I2C DUT 3x2 header — | Connect shunt between (DUT-BRD) to connect DUT and I2C data.
Connection Disconnect shunt and use 2-pin test point for Audio Precision between (DUT-
GND) to measure 12C data directly
J54 /RST /INT CSP 3x2 header — | Connect shunt between (DUT-BRD) to connect /RST and /INT data.
Connection Disconnect shunt and use 2-pin test point for Audio Precision between (DUT-
GND) to measure /RST and /INT data directly
J55 /RST /INT QFN 3x2 header — | Connect shunt between (DUT-BRD) to connect /RST and /INT data.
Connection Disconnect shunt and use 2-pin test point for Audio Precision between (DUT-
GND) to measure /RST and /INT data directly
J56 VD/VL Source 3x1 header — | Jumper between 1-2 to get VD/VL from 1.8 V banana jack (327). Jumper
Select between 2-3 to get VD/VL from 1.8 VA LDO
J57 MCLK CSP 3x2 header — | Connect shunt between (DUT-BRD) to connect MCLK. Disconnect shunt and
Connection use 2-pin test point for Audio Precision between (DUT-GND) to measure
MCLK directly
J58 MCLK QFN 3x2 header — | Connect shunt between (DUT-BRD) to connect MCLK. Disconnect shunt and
Connection use 2-pin test point for Audio Precision between (DUT-GND) to measure
MCLK directly
J60 QFN-XLR OUT XLR connector | O | The XLR out jack for the CS43131 QFN Device
J802 MCU 5x2 header /0 | Programmer for MCU
Programmer (shrouded)
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2.7.1

The table below shows a list of current measurement headers and the associated rails. To measure current of a particular
voltage rail, remove the jumper and place a current probe across the pins of the header.

Current Measurement Headers

Table 7 Current Measurement Headers

Header Voltage Rail
VP-QFN VP-QFN
VP-CSP VP-CSP
VA VA
VCP VCP
VL VL
VD VD

2.7.2

Push-Button Resets (Revision B Only)

There are 2 SPST push buttons for resetting the board in case the system enters an unknown state. There are 2 buttons:
S1 for a system-wide reset, and S2 for a DAC-only reset.

Table 8 Push-Button Resets

Button Name Descriptor Reset Tied To
S1 SYS_RESET CS43131-CSP, CS43131-QFN, CS8422 Smart Codec, USB MCU, USB HUB, XMOS
S2 DAC_RESET CS43131-CSP, CS43131-QFN

2.8 Codec MCLK Selection

The MCLK input to the smart codec can come either from the on-board 24.576 MHz clock oscillator, a 22.579 MHz clock
oscillator, MCLK1 from ASP(J25), MCLK2 from XSP(J26) or from the CLKOUT pin on the DAC or the MCLK output from
an external audio source. The selection is controlled by WISCE software.

/8 GPIO CONTROL (CDB431X%_1O... | & QUICK START (CDB431XX_JO_E... /) CDBA31XX_IO_EXP Register... | - X
Address Register Read | Write Walue Bit7 Bit6 Bit 5 ‘ Bitd Bit3 ‘ Bit2 Bit1 Bit 0
ROZh Input Port 2 Read FFh L] L SO 1 1 1
ROk Output Port 0 Read | Wite | FFh mmm‘ XTI_(LK10IJT_EN xn_(lmL:r_(sm 1 [ RESE‘I;_SH)F 1 1
ROSh Output Port 1 Read | Wite | FFh | OrD b AP FCTSPOr K rS | ASPMiS ’W TGS m
ROsh Output Port 2 Read | Wite | FFh 1 1 1 1 s ez |
ROCh Configuration Port0  Read | Write | FFh XlLOS(jLSJGMHZ,BU]R e R R e ‘ e ELrL L]
RODh  ConfigurationPort1  Read | Wite | FFh 5P DSD/SPOF DR ASP_PCMISPDE DR XSP_bi/s DR | ASP_W/s DR ‘ MCLEZ_HDR . DR MCLT_HDR MSDR | XTLMCLK2_BRO_BLDR. | T MCLKT_BRD_EN DR
ROER Configuration Port 2 Read | Write | FFh INT_DUT_DR INT_DUT2_ DR SPO1SFOFDR 1 RGO RIS
Figure 12 CODEC MCLK Selection
2.9 Clock Sources

The CDB43131 board has 2 separate onboard 22.5792 MHz crystals to act as the MCLK source for the CS43131 CSP
and QFN DUTSs. In addition to the crystal, the board also provides an option to supply MCLK either from an external
source, such as a function generator. These oscillators are Y1 (CSP) and Y2(QFN). By default, these crystals are
enabled. In order to use an external clock source, depopulate R11 (CSP) and R28 (QFN) and solder in a 0-Q resistor in
R10(CSP) and R39(QFN). The external MCLK is selected in the 10 expander in the WISCE software.

/8 GPIO CONTROL (CDB4300¢_10... |8 QUICK START (CDB4300_I0 E... /B8l CDBA31XX_IO_EXP Register... | - X
Address Register Read | Write | Value Bit 7 Bit 6 Bit 5 | Bit4 | Bit3 | Bit2 Bit1 Bit 0
ROZh Input Port 2 Read FFh IN'L‘DU'H |N'r,‘nu'rz Gpo1fsmf 1 ) )
RO3h Output Part 0 Read | Write FFh | XT_OSC_24pSTEMHZEN | XTI_OSC_22pSTS2MAZEN XTI_CLKOUT_EN XTI_CLKOUT_CSP/CFN RESET_SPOIF 1 1
1 1 1 1 1
. XSP_DSD/SPOF ASP_PCM/SFDF XSP_M/S ASP_MS MCLK2_HDR M5 MCLK1_HDR_MS XTI_MCLK2_BRD_EN XT_MCLK1_BRD_EN
ROSh Output Port 1 Read | Write FFh 1 1 1 | 1 1 1 1 1
ROGh Output Part 2 Read | Wiite | FFh 1 1 I =
: BTI_OSC_24 576MHZ BN DIR|...0SC_22 5792MHZENDIR|  XTI_CLKOUT EN DR ¥TI_CLKOUT_CSP/QFN DIR RESET_SPDF DR RESET_DUT2 RESET_DUTT
ROCh  ConfigurstionPort0  Read | Write | FFh i 1 1 | 1 1 I L
RODh  ConfigunstionPort1  Read | Wiite | FFh ¥SP_DSD/SPOF DR ASP_PCM/SPDIF DR XSP_M/S_DR | ASP_M/S DR | MCLK2_HDR_M/S DR MCLK1_HDR_MSDR | XTI_MCLK2_BRDENDIR | XT_MCLKT_BRD_EN DR
| 1 1 1 1 1 1 1 1
. . INT_DUT1_DR INT_DUT2_ DR GPO1_SPDF DR 1 MCLK_QFN_OE DR MCLK_CSP_OE DR
ROEh  ConfigurationPort2  Read | Wiite | FFh : : 1 ! 1 1
Figure 13 EXT MCLK Selection
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3 Board Control Register Quick Reference

Address | Register | Read | wite | Value Bit 7 Bit6 Bit5 | Bitd Bit 3 | Bit 2 | Bit 1 Bit 0
RO2h Input Port 2 Read FFh 'NT—1D”“ 'NT—EUT? 'SPO}SP‘} 1 1 1 1 1
R34 Output Port 0 Read | Write ECh xn,us(,zafsmﬂz,w m,os(,zzasigzm,EN xn,cmwounm K]L(lKOL:L(SPI(ﬂl 1 RESET{SFDI‘ 0 0
ROSh Output Port 1 Read | Write FFh xsp,ns::/smr ASPiPCWMISFDI‘ XSP?MIS ASP?M/S ‘ M(lKZJ{!DR,M‘S ‘ M(lKL:{DR,NVS XILM([KijI:LBI xn,Mch:jm,m
RO6h Quiput Port 2 Read | Write | FFh 1 1 1 1 1 1 “(lK—$FN—°E “(“‘{SP—“E
ROCH Configuration Port 0 Read | Write 0Bk X]LOS(){SSMHLBLDII xn,os(,zz,sgmmuz,m,un xn,(lkoguu,m XTI CLKOUT. E(SW"’DR 1 RESELSOPDEJJR RESET{DUI? RESETfDun
RODK Configuration Port 1 Read | Write 00h st,nsnésmF,Dﬁ AsP,P(Mésmr,nn np,nags,w ASPJ\g/SJJIl M(lxz,ngR,ws,m | M(m,ﬁgﬂ,wspn xn,M(manD,m,w HT_MCLKT bann,m,nn
ROER Configuration Part 2 Read | Write | FCh ""—D”f‘—“" ""—D“WTU" GPO‘—SWPD'U"‘ 1 1 1 “(“‘ﬂz"‘ﬁ@" M(l"ig’ﬁ@“ ‘
Figure 14 CDB43131 10 EXP Registers
3.1 Register Descriptions
3.1.1 Output Port 0
| Address: 0x04 | Default: 0XFC | RIW |
Bit Position 7 6 5 4 3 2 1 0
Bitfield XTI_OSC_2 | XTI_OSC_2 | XTI_CLKOU | XTI_CLKOU | RESERVED RESET_SP RESERVED | RESERVED
Name 4p576MHZ_ | 2p5792MHZ T EN T_CSP/QFN DIF
EN EN
Default 1 1 1 1 X 1 X X
Value
Bits Name Description
7 XTI_OSC_24p576MHZ_EN Enable 24.576 MHz CLK to be used as input to CODEC
0 Enabled
1 Disabled (Default)
6 XTI_OSC_22p5792MHZ_EN Enable 22.5792 MHz CLK to be used as input to CODEC
0 Enabled
1 Disabled (Default)
5 XTI_CLKOUT_EN Select SPDIF Clock Master
0 External CLK
1 CS43131 CLKOUT (Default)
4 XTI_CLKOUT_CSP/QFN Select Device to be SPDIF Clock Master
0 CSP CLKOUT
1 QFN CLKOUT (Default)
3 Reserved —
2 Reset_SPDIF Enable SPDIF Buffer
0 Disabled
1 Enabled (Default)
1:0 Reserved —
DS1155Vv2DB2 Cirrus Logic Confidential 15
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3.1.2 Output Port 2
| Address: 0x05 | Default: 0xOF | RIW
Bit Position 7 6 5 4 3 2 1 0
Bitfield XSP_DSD/S | ASP_PCM/S | XSP_M/S ASP_M/S MCLK2_HD | MCLK1_HD | XTI_MCLK2 | XTI_MCLK1
Name PDIF PDIF R _M/S R _M/S _BRD_EN _BRD_EN
Default 1 1 1 1 0 0 0 0
Value
Bits Name Description
7 XSP_DSD/SPDIF Set Codec in DSD/SPDIF Mode
0 DSD
1 SPDIF (Default)
6 ASP_PCM/SPDIF Set Codec in PCM/SPDIF Mode
0 PCM
1 SPDIF (Default)
5 XSP_M/S Set XSP as Master/Slave
1 Master (Default)
0 Slave
4 ASP_M/S Set ASP as Master/Slave
1 Master (Default)
0 Slave
3 MCLK2_HDR_M/S Set Codec as Master to MCLK2
1 Master (Default)
0 Slave
2 MCLK1_HDR_M/S Set Codec as Master to MCLK1
1 Master (Default)
0 Slave
1 XTI_MCLK2_BRD_EN Enable ASP MCLK to be used as input to CODEC
0 Enabled
1 Disabled (Default)
0 XTI_MCLK1_BRD_EN Enable XSP MCLK to be used as input to CODEC
0 Enabled
1 Disabled (Default)
16 Cirrus Logic Confidential DS1155v2DB2
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3.1.3 Output Port 3
| Address: 0x06 Default: OxFF | RIW
Bit Position 7 ] 6 [ 5] 4 [ 2 1 0
Bitfield Name Reserved MCLK_QFN_OE MCLK_CSP_OE
Default Value x | x | x | x | x 1 1
Bits Name Description
7:2 Reserved —
1 MCLK_QFN_OE Set Codec as Master to CSP
1 Master (Default)
0 Slave
0 MCLK_CSP_OE Set Codec as Master to QFN
1 Master (Default)
0 Slave
3.1.4 Port Config 1
| Address: 0x0C Default: 0x0B | RIW |
Bit Position 7 6 5 4 3 2 1 0
Bitfield XTI_OSC_2 XTI_OSC_2 | XTI_CLKOU | XTI_CLKOU Reserved RESET_SP RESET_DU RESET_DU
Name 4 576MHZ_ | 2 5792HZ_ | T _EN_DIR | T_CSP/QFN DIF_DIR T2 T1
EN_DIR EN_DIR _DIR
Default 0 0 0 0 X 0 1 1
Value
Bits Name Description
7 XTI_OSC_24 576MHZ_EN_DIR Direction of the XTI_OSC_24 576MHz_EN signal
0 Output (Default)
1 Input
6 XTI_OSC_22_5792HZ_EN_DIR Direction of the XTI_OSC_24_5792MHz_EN signal
0 Output (Default)
1 Input
5 XTI_CLKOUT_EN_DIR Direction of the XTI_CLKOUT_EN signal
0 Output (Default)
1 Input
4 XTI_CLKOUT_CSP/QFN_DIR Direction of the XTI_CLKOUT_CSP/QFN signal
0 Output (Default)
1 Input
3 Reserved —
2 RESET_SPDIF_DIR Direction of the RESET_SPDIF signal
0 Output (Default)
1 Input
1 RESET_DUT2 Reset DUT2
0 Disabled
1 Enabled (Default)
0 RESET_DUT1 Reset DUT1
0 Disabled
1 Enabled (Default)
DS1155v2DB2 Cirrus Logic Confidential 17
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3.1.5 Port Config 2

| Address: 0x0D | Default: 0x00 | RIW
Bit 7 6 5 4 3 2 1 0
Position
Bitfield XSP_DS | ASP_DSD/S | XSP_M/ | ASM_M/ | MCLK2_HDR | MCLK1 HDR | XTI_MCLK2 BR | XTI_MCLK1_BR
Name D/SPDIF PDIF_DIR S_DIR S_DIR _M/S_DIR _M/S_DIR D_EN_DIR D_EN_DIR
DIR
Default 0 0 0 0 0 0 0 0
Value
Bits Name Description
7 XSP_DSD/SPDIF_DIR Direction of the XSP_DSD/SPDIF signal
0 Output (Default)
1 Input
6 ASP_PCM/SPDIF_DIR Direction of the ASP_PCM/SPDIF signal
0 Output (Default)
1 Input
5 XSP_M/S_DIR Direction of the XSP_M/S signal
0 Output (Default)
1 Input
4 ASP_M/S_DIR Direction of the ASP_M/S signal
0 Output (Default)
1 Input
3 MCLK2_HDR_M/S_DIR Direction of the MCLK2_HDR_M/S signal
0 Output (Default)
1 Input
2 MCLK1 HDR_M/S_DIR Direction of the MCLK1_HDR_M/S signal
0 Output (Default)
1 Input
1 XTI_MCLK2_BRD_EN_DIR Direction of the XTI_MCLK2_BRD_EN signal
0 Output (Default)
1 Input
0 XTI_MCLK1_BRD_EN_DIR Direction of the XTI_MCLK1_BRD_EN signal
0 Output (Default)
1 Input

3.1.6 Port Config 3

| Address: 0XOE | Default: 0XFC | RIW
Bit Position 7] 6] 5] 4]3]2 1 0
Bitfield Name MCLK_QFN_OE_DIR MCLK_CSP_OE_DIR
Reserved
Default Value 1 [ 1] 1 ] x| x ] x 0 0
Bits Name Description
72 Reserved —
1 MCLK_QFN_OE_DIR Direction of the MCLK_QFN_OE signal
0 Output (Default)
1 Input
0 MCLK_CSP_OE_DIR Direction of the MCLK_CSP_OE signal
0 Output (Default)
1 Input
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4 CDB-HDR-MEAS High Dynamic Range Measurement Preamplifier

The CDB-HDR-MEAS is an ultralow-noise preamplifier circuit with +13.66 dB of gain. The CDB-HDR-MEAS is designed to
be used as a preamplifier to a high-performance audio analyzer to allow measurement of the high dynamic range (DNR)
of the CS43131. The CDB-HDR-MEAS preserves the dynamic range of the input signal while amplifying the input signal
by +13.66 dB to overcome noise floor limitations of the audio analyzer.

4.1 Powering the CDB-HDR-MEAS

The CDB-HDR-MEAS board requires a triple-output DC power supply capable of providing £15 V and GND connection at
100 mA, as shown in the figure below. Standard binding posts are provided for convenient connection of +15 V, GND, and
-15 V.

Triple Output DC
Power Supply

"m

s gcmus LogGic'
L ] COB-HOR-MLAS
amn
. LErT
~ l...ﬂ’
® 1

Figure 15 Powering CDB-HDR-MEAS
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4.2 How the CDB-HDR-MEAS Works

Since the noise floor of the APx555 is around —124 dB, and the CS43131 has a DNR of 130 dB, the signal needs to be
amplified to make it measurable. The following image illustrates this issue. In an ideal situation, the —60 dB signal during
DNR tests would yield a total dynamic range of 130 dB. However, due to a higher noise floor of the measurement
equipment, the difference results in a measurement error that hampers performance.

(s | R B M0+ |1}
-60dB [---=-=-===eeeeeeqy | e T -60dB
__________________________ Noise Floor >-130dB
Measurement Error
SBOHB | el o e i s e e e

CDB43131 Audio Precision

Figure 16 Testing Without CDB-HDR-MEAS

To rectify this issue, the input signal can be amplified (in this case by 13.3 dB). This will also amplify the noise floor;
however, since the noise floor is small compared to the signal, the signal will dominate the amplification. In the figure
below, the signal and noise floor have been shifted up to be at least on par with the noise floor of the measurement
equipment. Now when using the —60 dB signal for the DNR measurement, the full range of 130 dB can be measured.

-60dB

-130dB

CDB43131 CDB-HDR-MEAS Audio Precision

Figure 17 Testing With CDB-HDR-MEAS
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5 Testing the CS43131 using WISCE Software

The WISCE™ software interactive setup and configuration environment is an interactive tool for setting up and configuring
Cirrus Logic devices and software. The following sections show how to use WISCE software to configure and test
CS43131 and using the CDB43131 board and the CDB43131 Board.

5.1 Launching WISCE Software

Click on the Start Button -> All Programs -> Wolfson Evaluation Software and select "WISCE™ V3" to launch the WISCE
software.

. Visual Studic 2015 < |

, Windows Kits

. WinRAR

.. Wolfson Development

. Wolfson Evaluation Software
5] ADBBridge
X Quick Start Guide
7] SDBBridge
m7] WebOSBridge
57 WindowsBridge
X WISCEBridge™ User Guide
74 WISCE™ logs
L WISCE™ User Guide

B wscervd
] wm8s280
=1 WMEgAlgorithm
7] WMEgGLPFPlugin
.. Development

m

. Documentation
. Uninstall -

4 Back

| Search programs and files

2|

m

J

Figure 18 Launch WISCE
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The WISCE software is configured, by default, to scan the I12C bus and report the presence of any devices attached to this
bus. When the WISCE software is launched, it will report the presence of four unknown devices, one each at address
0x22, 0x44, 0x60 and 0x62 respectively. The device at address 0x22 is the CS8422 Codec, 0x44 is TCA6424, which is an
IO Expander. The device at address 0x60 is CS43131 CSP DUT, and the device at address 0x62 is the CS43131 QFN

DUT.

B wisce™
File  Edit View  System  Device History Tools Help
£ £ :
%% 06 iS
Systems L

@ Lochnagar 2.0 [COM15]
© L Unknown (B<FFFE) [SMEUS - (<20]
- Unknown (2eF7F7) [SMBUS - (edd]
-Z Unknown (2eFFFE) [SMBUS - ReB0)]
-F Unknown (eFFFE) [SMBUS - (62]
o gp [Add device.. ]

g [Add system.. ]

Figure 19 Found Devices

5.2 Loading the CDB43131 board Panel and Register Map

To load the CDB43131 board panel and register map, double click on the Unknown device at address 0x44 to launch
"Change Device" pop-up window. Alternatively, the "Change Device" pop-up window can also be launched by right
clicking on the Unknown Device and selecting Properties.

Change Device Iﬂ

Device

[CDB431X¢ 10 EXPRev1 | [ Load |

Conrtrol Interface
| SMBUS -|

Address
(st 5

oo

Figure 20 Select TCA6424

Select "CDB431XX_10_EXP Rev1" from the drop-down menu under Device.
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Click "Accept" to load the CDB43131 board Panel and Register Map shown in the following figures.

Figure 22 TCA6424 Register Map

& GPIO CONTROL (CDB4310X ... | B QUICK START (CDB4310X IO E... |5 CDB4300( 10 EXP Registers (C... | - X
GPIO CONTROL S0 [
- Mcix1
MCLK1_HDR_M/S
xse Siuis
n = |
(=[] MCLK2
e CS431XX
X5P_DSD/SPDIF
MCLK2_HDR_M/S - %P WS csp
curouT cse cukaur
BIXX
SPDIF RX + SRC MCLK BUFFER cukour
58422 ML QFN
oricaLm [ ReseT_ourt e
g > g
L) S ¢
COAXIAL RMCK 2
RESET_SPDIF =3
MCLK_GFN_OE [ RESET_DUT2
o XLR OUT
=
: =
5 & &8
USB MCU
XTIMUX
XT1_OSC_22p5792MHZ_EN
XT_05C_24p576MHZ_EN
XTI_WCLKI_BRO_EN noroe
XTI_MCLK2_BRD_EN
CDBA31XX_I0_EXP
CLKOUT.QFN =i
CLKOUT.CSP- ENABLE_DUTPUTS it
RTLCLROUT_CSP/QFN [ cor e
MUST ENABLE TO MAKE CONTROLS ACT IVE
! I} I
Figure 21 TCA6424 Panel
GPIO CONTROL (CDB431XX_10... |8 QUICK START (CDB431XX_IO_E... /' BHl CDBA31XX(_TO_EXP Register... | - X
Address Register | Read [ write | Value Bit 7 Eit6 Bit 5 Bitd Bit 3 Bit 2 Bit 1 Bit 0
ROZh Input Port 2 Read FFh 'NT—1D“" 'NT—1D“TZ ‘“’O‘fm’ 1 1 1 1 1
ROdh Qutput Port 0 Read | write FFh | YTLOSC_24pSTEMTEN | XTI OSC 22pSTS2MET EN ¥T_CLKOUT_EN WTI_CLKOUT_CSPAQFN q RESET_SFDIF q 1
1 1 1 1 i
WSP_DSDYSFOF ASP_PCM{SFDF HSP_M/S ASP_MAFS MCLE2_HDR M5 MCLE1_HDR M5 WTI_MCLK2_BRD EN YT_MCLK1_BRDEN
ROSh Output Port 1 Read | Witz | FFh i ] i 7 ‘ 1 1 1 1
ROEh Output Part 2 Read | Wite | FFh 1 1 1 1 1 1 MCLK.SFN_OE MClK_TCSP_OE
R0CH Configurstion Port0  Read | Write | FFh [TI-0SC_24 STGMHZENDI. 05C_22 STOMFZENDR| X1 CLKOLT ENDR | ¥11_CLKOLT_CSP/QFNLDIR 4 RESET_SPDIF DR RESET_DUT2 RESET_DUTI
1 1 1 1 1 1 1
RODK Configuration Part 1 Read | Mite | FFh ¥SP_DSD/SPDIF DR £5P_PCM/SPDF DR XSP_M/S_DR A5P_M/S DR ‘ MCLK2_HDR_M/S DR MCLKI_HDR MS DR | XTIMCLK2_BRD_ENDIR | XTI_MCLK1_BRD_ENDIR
1 1 1 1 1 1 1 1
ROEh Configuration Port?  Read | Wite | FFh LT R R 1 1 1 e MCLE_C5P_OE DR
1 1 1 1 1

DS1155v2DB2
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5.3 Loading the CS43131 Plugins and Register Map

To load the CS43131 Plugin and Register Map, launch the "Change Device" pop-up window by either double clicking on
Unknown Device or right clicking on Unknown Device at address 0x60 and selecting Properties. Select "CS43131 Rev
Al" from the Device drop-down menu and click Accept to load the plugin and register map for the CS43131.

Add device

Device

|C543131 Rev A1

Control Interface
| SMBUS -

Address
|60 ]

Figure 23 Select CS43131 CSP

i B
Change Device ﬁ

Device
|C543131 Rev Al

Accept

»| [ load |

Cortrol Interface
|sMBUS v

Address

[

)

Accept

Figure 24 Select CS43131 QFN

5 P10 CONTROL (COB4ID0IO... | [ QUIGK START (CDB4310(30_E. . | i COBATD0_JO B Regters (€... 5 543131 Registers (CS4T13..

Rddmss Regiser Read | Wits | Voo e o ais e Y [T e 60
w00 Devce DA a8 head ah B0 WL

Fan0in Dk D € mdD Read 1 DEVD0001 a2t

R0 DevieeDE hexs 108 oRMDEstorL .

s hand A RR=1us MTLRRD =001

R0tk fana | ith SUBREAD=1000 Do

Ra00tsh hent | wire | o e MELCSHC SEL-AC0
Rtk Rend| Wite | Oth A SPRATE=M 1

Aanch Read| Witz | 05h =2ty e
s ntaface Contiguration Resd | wee | 0n i -
wanoon Do D Controd Rend | wite | fEh FOR P Fo A PO gk L LA LR FOM CLEOAT

wa0oszh CrptaSeting hex| Wit | 0th HTAL EiASe 12508

A UL Seting 1 woad | ware | 00n ) AL
e PLL Setting2 hang | wite | 00h LD, FRAC =008 9000

R UL Seting 1 hest | were | 00n SLLLDIM FRAC 10080000

Ra000en PAL Seting 4 fesd| wime | 00h PLL_DIV_FRAC_2=00M_0000

Ra00ish PLL Seting 5 Red | wee | n FLL DR NT=010 9000

e AL Seing 6 Read | Witz | 20h PLL_OUT =000 o000 )
e PLL Seting? Read | Wi | 80h FLLcAL RaTI0=10m 000

Romeh UL Setting 8 hond | wits | Dh PipacoE

Az PLL Seting 1 Rand| Wita | 00h PLL_REF PRECIV=Divide by &
Ran0on CLROUT Contrl hang | wine | 00h CLHOUT ON=Dhade by CLIOUT,_ S8k <Tnterna LK
RaDO0h Read | Wit | 0th ASP_NLSO-1008 0L

ratoth hend | Wete | 00h A5 M58 =0009 g0

Rz Resd | wee | 03n AP MALSB=0M0_1000

RadDn Read| Witz | 00h 43P M50 S0

R0 Read| Wi | 1 AP LCHLLB S0 1111

s Rond | wite | 00 ASPLCHL SR 0004 8000

RA0016n pavd| wrm | 3 ASP LCPR LSB=t11, 1111

nnnnnn o ks 439 LCPR MIB0H0) i

Figure 25 CS43131 Register Map
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To view CS43131 plugin, click on Tuning and select "CS43131_Plugin.”

| /& cssararegsters (cs8422) @ 6PI0 CONTROL (CDB431XX_10... |[8 QUICK START (CDB431XX IO E... | C543131Registers (C543131) | CDB431XX_IO_EXP Registers (C... ) [l €543131_plugin (C543131) |

v X
Interface Internal Analog Supply 7
Supply (VL) Supply (VD) (VA VCP)
£ TSO +1.8V +1.8V FILT+FILT- HPINA  +1gy  Battery Supply
o Q Q 9 29 29 LA
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= 3 -0 FLYNZVA
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8 e Multibit
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Figure 26 CS43131 Plugin
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5.4 Initializing the Devices on the CDB43131 Board
The following steps show how to detect the presence of the CS43131s on the CDB43131 Board.

1. Under the CDB431XX_12C_GPIP_EXP menu, click on QUICK_START, and click CDB_INIT.txt. This will reset the

board into a default mode.

B9 CS422Regsters (C58422) |/ GPIO CONTROL (CDB430%(_JO... /& QUICK START (CDBA31XX_L.. | B C543131Registers (C543131) | BB CDB431XX_IO_EXP Registers (C... |8l 543131 puugn (c543131) |

- %

QUICK START EERATIEN]
Step 1, Step 2, Select Input: Step 3, Configure Device:
Initialize:
1. Optical S/PDIF Rx: CS43131 CSP:
D8 Sput i Oic ezt | Load script from:
2. Coaxial S/PDIF Rx: \Profiles\CS43131\CSP_0x60
CDB_Coax_In_Ck_Bxtsmal bt ‘
3. ASP Header: CS43131 QFN:
/ a. CS431XX Master: Load script from:
o8 e > OB PCM o DAC Meserst | > \Profiles\CS43131\QFN_0x62
b. CS431XX Slave:
CDB_PCM_in_Ext_Slave | CS43198 CSP:
3. XSP Header: Load script from:
a. CS431XX Master: \Profiles\CS43198\CSP_0x60
CDB_DSD_In_DAC_Master.td ‘
b. CS431XX Slave: CS43198 QFN:
COB_DSD.In_Be_Soveot | Load script from:
\Profiles\CS43198\QFN_0x62
[ . 3
Figure 27 Initialize DACs
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5.5 CS43131 Plugin

The CS43131 plugin has multiple tabs. Each tab provides an interface to configure and control specific IP Block(s) in the

CS43131. The following sections describe each tab and its function. The user can configure the CS43131 using these
tabs. However, it is recommended that the user initially use the profile scripts that are provided with the plugin to configure

and control the CS43131 since each field will be preconfigured correctly for the proper mode.

5.,5.1 Main Tab
This tab shows the block diagram of the internal architecture of the CS43131.

Clock Data Rauting (TCAG424) | B CS43131 Registers (C543131) B C543131_plagin (CS43131) |

3 Interface Internal Analog Supply
— Supply (VL) Swupply (VD) (VA VCP)
g TSO +18V +1.8V FILT+ FILT- HPINA +1gy  Battery Supply
¢ Q Q Q o 0 o Q Qo (VP)
— . 0 FLYC_VCP
: L - S HA
3 o Interrupt 9 I Vi
INT < nkesnol O VCP_FILT+
- Sources 3 Digital LDOs Voltage Charge Pump 0 VCPFILT
i = |oigital Core Refersscs -O FLYP_VA
3 3 O FLYNTVA
2 3 O VA
= PLL ] Interpolaton
é CLKOUT < Filter and ‘\ Mulbbit
c Volume ¥
< Control > AX
= — Modulator |-» HPOUTA
z XTO ¢ XTAL E=
3 0SC
b 3 VCP_FILT-
>
= : Interpolation
XTUMCLK Pleoee »
g = Filter and [ VCP_FILT+
é‘ SCLK1 * LA = Volume @ N ”:ghl ~
3 LRCKI 41— & . Modulator [ HPOUTB
% SDIN1 >3
g‘ DSDCLK/SCLK2 < » = |y DoPto
XSP/DSD DSD > 0SO
&  DSDBLRCK2 «—» Lo Audio » Engine 2
= Intestace > Procssaar
DSDA/SDIN2 > - HP Detect, |« HPREFA
p?g"cz“r"; HP Impedance | HPREFB
W Detectand |
Reg;l:;:&;ﬂ%me d—b{ Control Port Level Transiator Measwure % HP_DETECT
1
L/
ADR SDA SCL RESET HPINB

Figure 28 Main tab
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55.2

Sys_Config Tab

This tab allows user to configure the CS43131 clock input settings. It also allows the user to configure CLKOUT and
Class-H amplifier settings.

/B ClockDataRouting (TCA6424) |'BE  CS43131Registers (C543131) V@ €S43131_plugin (C543131) |

28

= System Configuration
g
g MCLK and Crystal Configuration Class H Control
>
w
E MCLK Source RCO. - Power Adjustment Adapt to Signal ~
g Frequency 22.5792MHz ¥ VCPFILT Source Disable >
=
2 XTAL Bias Current 12.5uA Y.
= High Voltage Mode (I
B
E | Enable XTAL Interrupts
o
2 T —
—_ XTAL Status
= Module Power Control
§ Ready D Error D
7] Power Down CLKOUT =
_{" =
_g CLKOUT Control Power Down XTAL
=
=
& CLKOUT Source Intemnal MCLK  ~
-
3 Divider Divide by 2 -
=
2
(=]
Figure 29 Sys_Config Tab
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The example below shows the sequence of steps that should be followed to select On-board Crystal as MCLK source
using the Sys_Config tab.

1
2
3.
4. Click on XTAL Status button. If "Ready" LED is lit, the crystal Interface has been configured successfully, and the

. XTAL bias is set by default to 12.5 pA.
. Click on the Enable XTAL Interrupts check box to enable crystal interrupts.

Power up the Crystal Interface by clicking on the Power Down XTAL LED (LED color will change to Red).

CS43131 is ready to use XTAL as MCLK source. Go to step 6.
If "Error" LED is lit, then the crystal interface is not configured. Power down the board. Check the crystal and the
crystal circuit on the board.
Select "XTAL" from MCLK Source drop-down menu to select XTAL as MCLK Source.

Clock Data Routing (TCA6424)

|'B8 CS43131Registers (CS43131)

@ 543131 _plugin (C543131) |

MCLK and Crystal Configuration

System Configuration

Class H Control

3
g
o
&
2 MCLK Source [MCLKIXTAL  ~| Power Adjustment | Adapt to Signal |
& Frequency (225792MHz  ~| VCPFILT Source Disable -
bt
3 XTAL Bias Current | 12.5uA -
= e — High Voltage Mode ]
§ V' Enable XTAL Interrupts
%
= XTAL Status
= P Module Power Control
5 Ready [ Error a
z Power Down CLKOUT =
g CLKOUT Control Power Down XTAL .
E
= [ 1
S OCLKOUTSource |intemal MCLK v
S Divider Diideby2 |
&
2
=X
Figure 30 Sys_Config Tab with XTAL as MCLK Source
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5.5.3

PLL Tab

This tab allows the user to configure the CS43131 PLL. The PLL can be used as an alternate source for the CS43131
MCLK.

/B CockDataRouting (TCAS424) | T C543131 Regsters (C543131) VMl C543131_plugin (C543131) |

PLL] SYS Conlig | Main

| DSD Playback | PCH Playback | XSP Ceafig | ASP Conlig | Hesdphone ||

PLL_REF_

PLL Configuration

PON_PLL

| PLL_START

PLOUT_ L .oy our

PREDIV

PLL_REF

PLL

Div

l PON_DIV_INT

PLL_DIV_FRAC
PLL_MODE

PLL_DIV_INT + PLL_DIV_FRAC 1

PLL_OUT =
- PLL_REF_PREDIV

5007512 or 1, Selected by PLL_MODE PLL_OUT_DIV

PLL Setup PLL Configuration Values

Power Down PLL =
PLL_REF_PREDIV PLL_DIV_INT PLL_DIV_FRAC

PLL_REF PLL_OUT

Enable PLL Interrupts PLL_OUT DIV PLL_CAL_RATIO
| PLL Output Enable
| PLL Status |

PLL_MODE |

Ready 0O Eror [

Figure 31 PLL Tab
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5.5.4 Headphone Tab
This tab allows the user to perform the following functions:

1. Enable/disable headphone output
2. Enable analog passthrough
3. Enable headphone presence detection
4. Initiate headphone impedance measurement
Clock Data Routing (TCAS424) | B CS43131Registers (C543131)  / €S43131_plugin (€S43131) L

Headphone Operations

- RN

__'-: Impedance Sub-System Config

8 g Enable 1 Status
e Enable Headphone Output

&

— Enable Impedance Sub-System

z

Read PON_HP Status

g DC Impedance Measurement

§ Power Down HP Stal D

g HI tus | Left Channel Ohmsa
%‘ External HP Input Right Channel Ohms
:

_<:_ Clamping Opt-Out AC Impedance Measurement

uﬁ HPOUTA HPOUTB Fi Hz

g & @

ot Swoep

3 Output Full Scale Voltage

£ 1.732v = Left Channel | Ohms

:

- Right Channel Ohms

-

"i Headphone Detection

g

2 Enable HP Detect

(=]

Read HPDETECT Status |

Headphone Detected a
Headphone Unplugged (3

Figure 32 Headphone Tab

5.5.4.1 Enabling Headphone Output

ON  OFF UNPLUG OUT OF RANGE
0] @] @] @]

Status
DCOnce  DC Done

0] 0]

The following steps show how to enable the headphone output using the Headphone tab.

. Enable headphone interrupts by checking the Enable Headphone Interrupts check box.

. Configure MCLK source. Configure audio input port.

1
2
3. Power up headphone by checking the Enable Headphone Output check box.
4

. The headphone output should be powered up.
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5.5.4.2 Disabling Headphone Output

The following steps show how to disable the headphone output using the Headphone tab.

1.

arwn

If the CS43131 just came out of reset, the headphone output is already disabled, so the remaining steps can be
skipped.

Enable headphone interrupts by checking the Enable Headphone Interrupts check box.

Uncheck the Enable Headphone Output check box to power down headphone.

Click on Read PDN_HP Status button to read the status of PDN_HP bit.

If the PDN_HP bit is set, then the Power Down HP Status LED will turn red to indicate headphone has been
powered down.

5.5.4.3 Enabling Analog Audio Passthrough

The following steps show how to enable analog audio passthrough.

1.
2.

3.
4,

Connect audio output from a source to the HPIN jack on the CDB43131 board.

If the CS43131 is coming out of reset, enable analog audio passthrough by checking the External HP Input check
box. Else, skip to step 3.

Disable the headphone output if it is not already disabled.

Enable analog audio passthrough by checking the External HP Input check box.

5.5.4.4 Headphone Presence Detection

The following steps show how to enable headphone presence detection.

1. Enable headphone interrupts by checking the Enable Headphone Interrupts check box.
2. Enable invert detection (to account for the tip detect pin setup of the headphone jack) by checking the Invert Detect
check box.
3. Enable headphone presence detection by checking the Enable HP Detect check box.
4. Click on the Read HPDETECT Status button to read status.
5. If a headphone is plugged into the headphone jack, then the Headphone Detected LED will turn green.
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5.5.4.5 Headphone Impedance Measurement

The plugin supports both DC and AC impedance measurement. For AC impedance measurement, it supports both
measurement at one frequency or measurement across entire audio band. Any jumpers on headers J28 and J29 should
be removed before starting impedance measurement.

5.5.4.5.1 Measuring DC Impedance

The following steps show how to measure DC impedance. A headphone should be connected to headphone jack J1 on
the CDB43131 board to do the measurement.

Set XTAL as MCLK source.

Power down headphone, if not already powered down.

Enable impedance interrupts by checking Enable Impedance Interrupts check box.

Enable impedance subsystem by checking Enable Impedance Subsystem check box.

If the ON Status LED turns green, then the impedance subsystem is enabled. Proceed to step 5. Else, the
impedance subsystem did not get enabled. Power cycle the board.

Click the Left Channel button to start DC impedance measurement for the left channel.

7. Once the impedance measurement is complete, the measured impedance will be displayed in ohms.

8. Click the Right Channel button if DC impedance measurement of the right channel is desired.

agrwnE

o

Headphone Operations

Impedance Sub-System Config

V| Enable Impedance Interrupts Status ON OFF UNPLUG OUT OF RANGE

a a Qa a

V] Enable Impedance Sub-System

DC Impedance Measurement
Status

| LeftChannel | 2525 Ohms DCOnce DC Done

a

[ Right Channel ] 25 Ohms

Figure 33 DC Impedance Measurement
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5.5.4.5.2 Measuring AC Impedance

The following steps show how to measure AC Impedance. A headphone should be connected to headphone jack J1 on
the CDB43131 board to do the measurement. DC impedance should be measured before measuring AC Impedance.

1. Enter the frequency at which the impedance should be measured into Frequency box.

2. Click the Left Channel button to start AC impedance measurement for the left channel.

3. Once the impedance measurement is complete, the measured impedance will be displayed in ohms.
4. Click the Right Channel button if AC impedance measurement of right channel is desired.

AC Impedance Measurement

Frequency 1000 Hz
| Sweep
Status
36.375 Oh
| Left Channel | e AC Done No DC Done
| Right Channel |  36.375 Ohms a o

Figure 34 AC Impedance Measurement
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5.5.4.5.3 Measuring AC Impedance Across a Range of Frequencies

The following steps show how to measure AC impedance across a range of frequencies. A headphone should be
connected to headphone jack J1 on the CDB43131 to do the measurement. DC impedance should be measured before
measuring AC impedance. When the "Start" button is clicked, a logarithmic sweep from Start to Stop Frequency,
controlled by the value of “# of points", will begin. The measured values will be plotted on the graph in real-time. While the
sweep is in progress, the “Start” button will change to “Abort” button. By clicking on the “Abort” button, the user can abort
the AC Impedance Sweep process. When measurement is complete, “Abort” will revert back to “Start”

Enable frequency sweep by checking Sweep check box. This will load AC frequency sweep controls.

Enter the "Start Frequency", "Stop Frequency" and the "# of Points".

Click the "Start" button next to "Left Channel" to start AC impedance sweep for left channel and real time plotting.

Click the "Start" button next to "Right Channel" to start AC impedance sweep for right channel and real time

plotting.

5. To save left channel sweep data, click "Save Left CH Data" button. An explorer dialog will open, and the user can
save channel impedance data and the corresponding frequency as a .CSV file at desired location

6. To save right channel sweep data, click "Save Right CH Data" button. An explorer dialog will open, and the user
can save channel impedance data and the corresponding frequency as a .CSV file at desired location

7. Save the graph as a .PNG file by clicking on the Save Image button. An explorer dialog box will open to allow the

user to save the image at the desired location.

e\ e

AC Impedance Measurement

Start Frequency 2 Hz Stop frequency 20000 Hz # of Points 64
V] sSweep
Status
Left Ch 1
& e St AC Done No DC Done
Right Channel Start a a

AC Impedance Chart

50 Impedance
= Left Channel
= Right Channel

40 =~ .

.E 30 < Data
o
8 T \
: 4
T 92 Save Right CH
o / Data
E
y
10 =
Save Image
0
10 100 1000 10000

Frequency (Hz)

Figure 35 AC Impedance Sweep for Shure SE535 Headphone
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5.5.5 ASP Config Tab

This tab allows the user to configure the ASP port. The following figure shows ASP Config tab contents when ASP is

configured to operate in Slave mode.

/@ CodDataRoutng (TCA6424) | B8 CS43131Regsters (C543131) M €S43131_plugin (C543131) |

i ASP Configuration

g Port Config Channel Configuration

2 Enable ASP Interrupts Channell Channel2

= Power Up ASP Enable r e -

E 0P Wads Location [} 0 Location [} B

2 [Stave = (ASPSCLKs) 255 (ASP SCLKs) 0 255

._E Channel Size 'Adive Phase _Channel Size Adna Phase )
g‘ 24bits ~| LRCKIFSYNC Low  ~ | 24bits - | LRCKIFSYNC High |
oo

2| Sample Rate o )

E ;“.‘lkﬂz - Configuration

8 SCLK LRCLK

o

5 | Seepletiea Input Polarity __Output polarity  Input polarity Output Polarity
3 — - Lo z lnverted > Normal % |Moemel )

)

g Frame Configuration

g

e} ASP Data Type

= LRCLK hiah Time

é . (in SCLK cycles)

2

= LRCLK Period 64

ASP Frame Start i
|LRCK Highto Low  ~ P —
Overflow  LRCLK Eror  LRCLK Late LRCLK Early  No LRCLK
a ®) a a Q
Figure 36 ASP Config Tab
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The following figure shows the contents of ASP Config tab when ASP is configured to operate in Master mode.

/@ ClockData Routing (TCAB424)

VB 543131 Regsters (CS43131)

V@ s43131_plugin (C543131) |

5 ASP Configuration

§ Port Config Channel Configuration

4 Enable ASP Interrupts Channel1 Channel2

a Power Up ASP Enabl r Enable r
F | MPiode Location _ . Location [} .

o lf&!‘—‘! v (ASP SCLKs) 0 255 (ASP SCLKs) 0 255

- e

:% Channel Size A_guva Phase - Channel Size Active Phase

.§ ASP 3_State r | 24bits v LRCK/FSYNC Low  ~ | 24bits - |LRCK/FSYNG High |
&

43 Sample Rate X 3
ERrE - SodkConfowntion

K SCLK LRCLK

[+ % I 2

2 Ezs: % s Poleiy - _Output polarity Input polarity Output Polarity
g Inverted v Lh!!‘fg Y !LNO"“" '_l | Normal ¢
)

g Frame Configuration

§. SCLK Frequency KHz LRCLK Frequency KHz
E ASP Data Type

- LRCLK high Time

g 128 ASP Numerator 1 (in SCLK cycles) 32

o

§ ASP Denominator 2 LRCLK Period 64

 Calculate |
ASP Frame Start
LRCK Highto Low = e
Overflow  LRCLKError LRCLKLate LRCLKEarly  No LRCLK
a @) a a a
Figure 37 ASP Config Tab in Master Mode
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Click the Calculate button to determine the frequencies of the SCLK and LRCLK signals. When this button is clicked, the
SCLK and LRCLK values will be calculated based on the selected frequency of Internal MCLK (MCLK_INT) and the

values in ASP Numerator, ASP Denominator, LRCLK high Time and LRCLK Period text boxes. The value in the LRCLK
Frequency text box will be used to set the new sample rate (if it is not already set by user) when the ASP is powered up.

Clock Configuration
SCLK LRCLK

Input Polarity Output polarity Input polarity Output Polarity
Inverted v] llmremed v] [Nonnal v] [Normal v]
SCLK Frequency 2822 4 KHz LRCLK Frequency 44 1 KHz

LRCLK high Time
ASP Numerator 1 (in SCLK cycles) 32
ASP Denominator 8 LRCLK Period 64
Calculate

Figure 38 Calculating ASP Clock Frequencies

It is recommended to use a profile script to configure this port since each field will be preconfigured correctly for the
proper mode.
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5.5.6 XSP Config Tab

This tab allows the user to configure the XSP port. The following figure shows XSP Config tab contents when XSP is

configured to operate in Slave mode.

/@ ClockDataRouting (TCA6424) |'B§ CS43131Regsters (C543131) V[ €S43131_plugin (C543131) |

Port Config
| Enable XSP Interrupts

" | Power Up XSP

XSP Mode
Slave >,

Sample Size
24 bits vl
Frame Config

XSP Data Type
128 v

XSP Frame Start
|LRCLK High to Low

4

| DSD Playback | PCH Playback | XSP Conlig - ASP Config | Headphone |  PLL | SYS Config | Main

Figure 39 XSP Config Tab in Slave Mode

XSP Configuration
Channel Config
Channel 1 Channel 2
Enable |5 Enable I~
Location [} 0 Location '")
(XSP SCLKs) o 255 (XSP SCLKs) s 0
Channel Size Active Phase Channel Size Active Phase
24bitsisample v | v 24bitsisample ¥ | v
Clock Config
SCLK LRCLK
Input Polarity Output Polarity Input Polarity Output Polarity
bmﬁe_d 'J Inverted - iNonnal 'J | Normal 'J
LRCLK High Time
(In SCLK cycles) 32
LRCLK Period 64
Calculate
XSP Status
Overflow LRCLK Error LRCLK Late LRCLK Early No LRCLK
a a @) a a

DS1155v2DB2
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The following figure shows the contents of XSP Config tab when XSP is configured to operate in Master mode.

/[E Clock Data Routing (TCA6424) }’E CS43131Registers (CS43131) V@ €543131_plugin (CS43131) |

£ XSP Configuration
=
£ Port Config Channel Config
3 Channel 1 Channel 2
< Enable XSP Interrupts

= : Enable = Enable 7]

B Power Up XSP

L Location [—J o Location D
g XSP Mode (XSPSCLKs) 0o 255 (XSP SCLKs) 0
'?i P 0 255
E Channel Size Active Phase Channel Size Active Phase

P 24bi v v 24bits/sample ¥ v
g XSP 3_State r B ] [ | |
o Sample Size
2 (24 bits = Clock Config
3? SCLK LRCLK
[

& Frame Config r Input Polarity Output Polarity . Input Polarity - ) Output Polarity
E | Inverted '] [lnverted '] \Nomul '] | Normal ']
2 XSP Data Type
§ 12S v SCLK Frequency KHz LRCLK Frequency KHz
% LRCLK High Time
'§, XSP Frame Start XSP Numerator 1 (In SCLK cycles) 32
= 'LRCLK High to Low | XSP Denominator 2 LRCLK Period 64
&

Calculate
XSP Status

Overflow LRCLK Error LRCLK Late LRCLK Early No LRCLK

a a a a a

Figure 40 XSP Config Tab in Master mode
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Click the Calculate button to determine the frequencies of the SCLK and LRCLK signals. When this button is clicked, the
SCLK and LRCLK values will be calculated based on the selected frequency of Internal MCLK (MCLK_INT) and the

values in XSP Numerator, XSP Denominator, LRCLK high Time and LRCLK Period text boxes. The value in the LRCLK
Frequency text box will be used to set the new sample rate (if it is not already set by user) when the XSP is powered up.

Clock Config
SCLK LRCLK
Input Polarity Output Polanity Input Polarity Output Polanty
Inverted '] [Inverted '] [Normal '] [Normal v
SCLK Frequency 2822 4 KHz LRCLK Frequency 44.1 KHz
LRCLK High Time
XSP Numerator 1 (In SCLK cycles) 32
XSP Denominator g LRCLK Period 64
Calculate

Figure 41 Calculating XSP Clock Frequencies

It is recommended to use a profile script to configure this port since each field will be preconfigured correctly for the
proper mode.
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5.5.7 PCM Playback Tab

This tab allows the user to configure PCM playback path. This tab allows the user to change PCM filter dynamically during
playback. The impulse and magnitude responses of the selected filter are displayed. It is recommended to use a profile
script to configure this part since each field will be preconfigured correctly for the proper mode.

Clock Data Routng (TCAS424) | B8 CS43131 Registers (C543131) M €543131_plugin (C543131) |

:5 PCM Playback
g Filter Seloct
g FastRollLowLat - 7 High Pass Filter De-Emphasis
£
= Impulse Response
g
.% 12
= 1
£ Z o8
g £ oe g
= 04 9
: 4 3
& B 02 b
o = 0 g
4
5 g B
Jé -0.4
& -06 : ; : :
@ 0 500 1000 1500 2000 2500| 04 05 086 07 08 09 1
? Time (us) | Frequency (Normailized to Fs)
:
E
2
—
Volume Control
Channel Control Mute Control
— - Channel A Channel B

Invert Channel A | Mute CH A | MuteCH B

Invert Channel B v ey . Volume 2 2556? 2 U 255;?

Swep Asnd B Auto Mute | Auto Mute B=A S

CopyAto B | B=A

) Ramp Mode
7 Controlied Ramp Down sonnmom, -
Figure 42 PCM Playback Tab
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5.5.8 DSD Playback Tab

This tab allows the user to configure the DSD/DoP playback path. It is recommended to use a profile script to configure
this port.

Clock Data Routing (TCA6424) | B CS4313Registers (C54313) @ C543130_plugin (C54313) |

DSD Playback

DSD Interface Config DSD processor Config
[] Enable DSD Interrupts DSDEnable M DSD Source DSD Speed
‘ (pspiF - [64Fs -]
‘ [”] Enable DoP Interrupts
Power Down DSD Interface | [] static DSD Detect PCM 0dB Match
= ! SACD3.1dB  ~ DSD = PCM
ot B Emmpename.
DSD PM Enable | |
[¥] High Pass Filter [] Invert CH A [] Invert CHB
0D PM Mode
[7] SwapAand B [l CopyAtoB

DSD PCM Mixing
Volume Control
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Channel A Channel B

[”] Mix PCM and DSD
Volume U O
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Mute Control
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Soft Ramp Control
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Figure 43 DSD Playback Tab
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6 Testing Various Use cases

Profile scripts are provided along with the plugin to allow the user to test various common use cases. The profile scripts
for CS43131 can be found in {WISCE_INSTALL_FOLDER}/Profiles/CS43131. If needed, users can create their own
profile scripts to suit their requirements. Individual scripts are provided for each combination of Sample Rate and Output
Voltage level for both PCM and DSD modes. The following table shows the list of supported use cases along with

corresponding profile scripts.

Table 9 Profile Scripts

Use Case DAC mode

Scripts (for CS43131)

Audio Input Source

PCM Playback Master

CDB_PCM_In_DAC_Master,
ASP_Master_PCM_Playback_xxx_yyy !
XxX is the sample rate

yyy is the output voltage level

PCM through ASP header (J25)

PCM Playback Slave

CDB_Spdif_In_CIk_External,
XTAL_In_ASP_Slave_PCM_Playback_xxx_yyy ?
Xxx is the sample rate

yyy is the output voltage level

SIPDIF (J10)

CDB_Coax_In_Clk_External,
XTAL_In_ASP_Slave_PCM_Playback_xxx_yyy 2
XxX is the sample rate

yyy is the output voltage level

Coaxial (J11)

CDB_PCM_In_Ext_Slave
XTAL_In_ASP_Slave_PCM_Playback_xxx_yyy 2
XxX is the sample rate

yyy is the output voltage level

PCM through ASP header (J25)

DSD Playback Slave

CDB_DSD_In_Ext_Slave,
Slave_DSD_Playback_xxx_yyy 3
xxX is the DSD Speed

yyy is the output voltage level

DSD through XSP header (J26)

DoP Playback (64fs Mode) Slave

CDB_PCM_In_Ext_Slave,
DoP_DSD64_playback XTAL_Slave

PCM through ASP header (J25)

CDB_Spdif_In_CIk_External,
DoP _DSD64 playback XTAL Slave

SIPDIF (J10)

CDB_Coax_In_Clk_External,
DoP_DSD64 playback XTAL_Slave

Coaxial (J11)

DoP Playback (128fs Mode) Slave

CDB_PCM_In_Ext_Slave,
DoP_DSD128 playback XTAL Slave

PCM through ASP header (J25)

Headphone Detection —

Headphone_Detection

Analog Passthrough —

Analog Passthrough

CS43131 CSP HPIN (J16)

Switch from Analog Passthrough Slave
to PCM Playback

CDB_PCM_In_Ext_Slave,
Switch_Analog to PCM_asp_slave

PCM through ASP header (J25)

Switch from PCM Playback Slave

to Analog Passthrough

CDB_PCM_In_Ext_Slave,
Switch PCM_to_Analog

PCM through ASP header (J25)

Switch MCLK frequency —

Switch_MCLK_Frequency

Notes:

1. For example, if the desired sample rate is 48 kHz and desired output voltage is 1 V, then load the
ASP_Master PCM_Playback 48K_1VO0 script.
2. For example, if the incoming sample rate is 48 kHz and desired output voltage is 1 V, then load the
XTAL_In_ASP_Slave_PCM_Playback 48K_1VO script.
3. For example, if playing back DSD stream at 64 Fs and the desired output voltage is 1.7 V, then load the

Slave_DSD_Playback 64fs_1v7 script.

Table 10 Additional Profile Scripts for CS43131

Script

Function

Power_Up HP

Power up HP and ASP (for PCM/DoP playback)

Power Up HP_DSD_mode

Power up HP (for DSD playback)

Power Down HP_PCM_ mode

Power down ASP and HP

Power Down HP DSD mode

Power down HP
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6.1 Data Flow for Various Use Cases

The following sections depict the flow of data, in red, for various common use cases.

6.1.1 PCM Playback

Smart CODEC CS43131
Analog Audio Input
a HPOUT = HPIN
AIF2TX
- G " HPOLF————
= DoP_IN
AIF1IRX =
#{ DSD_IN
PCM
N
b
SPDIF PCM/DoP DsSD
Figure 44 PCM Playback Data Flow
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6.1.2 DSD Playback
Smart CODEC CS43131
Analog Audio Input -
HPOUT I‘-D #| HPIN
AIF2TX 3
PCM/
" por_IN HPOL—"
AIFIRX 1 - -
- ffsb;m
PCM
» >
SPDIF PCM/DoP DSD
Figure 45 DSD Playback Data Flow
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6.1.3 Analog Audio Playback

Smart CODEC CS43131
Analog Audio Input —
Analog Audio
HPOUT| 2 HPIN
AIF2TX \\\\
pCM/ S .
boP_IN HPOUT
AIF1RX [
» DSD_IN
A
SPDIF PCM/DoP DSD
Figure 46 Analog Audio Playback Data Flow
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6.2

Measuring Dynamic Range and THD+N for the CS43131

This section describes the test setup and the procedure to measure dynamic range and THD+N for CS43131.

6.2.1

Test Program Setup

The following steps show how to setup the CDB43131 for THD+N measurement. Please make sure that the CDB4131
jumpers are set to factory default mode.

1. Power up the CDB43131 by applying +5 V or VBUS through a USB connection.
2. Connect a cable from "Digital Serial 10" Transmitter port of an APx (e.g. APx555) to header J25 on CDB43131
board. There is no need to connect the MCLK signal.
3. Follow the steps described in the Quick Setup Guide to launch WISCE software and load plugins.
4. Load the profile script CDB_PCM_In_Ext_Slave from {WISCE_INSTALL_FOLDER}/Profiles/CS43131.
7/ M )J
, @
“.m—’
DIGIVAL S(lIAL 10
o e
f—_ ‘—1!‘
coBa
e 40047
;(IIU\UQ LOGIC
CO6e 3131
Figure 47 Test Setup
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6.2.2 APx Setup
The following steps show how to configure the APx for running the tests. This procedure was tested using an APx555.

1. Run the APx software. (APx500 v4.2 if using an APx555)
2. Setthe APx Output to Digital Serial and Input to Analog Balanced.
3. Set the Input Bandwidth to 20 Hz to 22.4 kHz.

Signal Path Setup

Input/Output v

. Serial Transmitter

B

Figure 48 APx Signal Path Setup
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4. In the Signal Path Setup panel, click on the settings button next to Connector drop-down menu and configure
Digital Serial Settings as shown below.

W N
Output Settings (Digital Serial Transmitter) d==d| | PS !

Configuration: Serial Transmitter [ Open... ] [ Save... ]

« Audio « Clocks « Bit Clock Edge Sync

® Single Data Line (TOM) Master Clk Source: Outs:

[ﬁ (2] 3] [4] Master Clk Rate: _ Ins: |Rising
) Multiple Data Lines MCIk Output: on [Invet * Logic
Format: |125 >/ Frame Clk Rate: 480000kHz & Outputs:
Justification: | Left Justified MCIk/FClk Ratio: 256
Frame Pulse: | One Subframe « Frequency
s 5 Scale Freq By: | Output SR v
Word Width: 32 [
BitDepth: 24 = [¥] Dither

Bitclk pLILILILIL 2

Frame D S &,

Datal p Chl. LsB ——{MSB ch2 |

< | m »

l Close ] [ Help
o
Figure 49 Digital Serial Settings
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5. To launch the Dynamic Range Measurement test, click on Project-> Add Measurement -> Meters -> Dynamic

Range - AES17. This will launch the dynamic range test screen.

24 Project - APx500 v4.2.1 (APx555 Demo Mode)

File

Bl ek K& VL

Navigator

—

View Measurements Project Window Help

Add Signal Path

Add Measurement

All

s QEEERRA B i

Sequence: Sequencel Add Primary Result Acoustic »
— [ Bl & Define New Result Basic 3
& Project Delete Crosstalk >
m Sequencer Properties... Distortion »
» (& Pre-Sequence Steps 3 start Sequence Band o
v F252 Signal Pathl J start Selected Signal Path nop e
[J Start Selected Measurement PAUAEIN ¥ |l cwin
S »
£ Messurement Sequence 3 start Sequence From Selected Measurement it CHRRIEC
» (G Sequence Steps = - - Crosstalk, Custom
8 : zms bt Edit Reprort Properties... Crosstalk, One Channel Driven
ain T H
) @ THD+N Ratio B2 Edit Data Output Properties... :] E\ Crosstalk, One Channel Undriven
O @ Frequency [ Sequencer Properties... — DC Level
0O sits [ Project Properties... DC Level (DCX)
LIS e e Termination: |200 kohm  + DIM
» (] Level and Gain =
» O THD+N ["] Use High Perf SineAnh Dynamic Range - AES17
» [J & Frequency Response Frequency
» (] Signal to Noise Ratio - Filters IMD (DFD/MOD/SMPTE/CCIF)
» [ Crosstalk, One Channel Undriven High-pass: [Elliptic vl 20 Hz Input Sample Rate
» [/ Interchannel Phase
e Interchannel Phase
Add Measurement... Low-pass: [ADC passband 'l Level and Gai
E¥ Add Signal Path ) Vel ahd oall
v [ Post-Sequence Steps Fancandie [ZZAk {45 kkiz SR) ] Level Ratio
ﬁ!d Step... Weighting: [None v] Maximum Output
EF| Report p— _‘ £ %
OB Data Output £Q [None 'l BN channets... Maximum Output (CEA-2006)
: o Modulated Noise
« Device Under Test Noise (Q-peak per ITU-R BS.468-4)
Delay: 0.000 5 Noise (RMS)
PSR
Resistance (DCX)
Verify Connections Signal to Noise Ratio
- SINAD
[ Generator (@ or | THD+N
Figure 50 Launch Dynamic Range Test
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6. To run the Dynamic Range Measurement test, configure the Input Level and Bandwidth as shown below. Click on
the "Start" button to run the test. Dynamic Range values will be displayed for both channels.

< Dynamic Range - AES17

Figure 51 Dynamic Range Test
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7. To launch THD+N test, click on Project-> Add Measurement -> Meters ->THD+N to launch THD+N measurement
window.

24 Project - APx500 v4.2.1 (APx555 Demo Mode)
File View Measurements Project Window Help

Bl R eV E8h Add Signal Path
Navigator Sil Add Measurement All
Sequence: Sequencel o Add Primary Result » Acoustic y Lo B B E =- 3 B | unit
) El Define New Result > Basic N
& Project Delete N Crosstalk »
E] Sequencer Properties... Distortion N
» [ Pre-Sequence Steps 3 start Sequence = o
v B33 Signal Pathl 0 start Selected Signal Path nopass sy
[J start Selected Measurement il e
S >
£ Measurement Sequence 3 start Sequence From Selected Measurement ot CMRRIEC
» [Gr Sequence Steps Crosstalk, Custom
g : gMS bevd Bdix Repart Propucties; . Crosstalk, One Channel Driven
amn 1 1
o b st B Edit Data Output Properties... 3 = Crosstalk, One Channel Undriven
O @ Frequency Bl Sequencer Properties... : DC Level
OO sits 3 Project Properties... DC Level (DCX)
LG fios Kepe Termination: |200 kohm  + DIM
» (] Level and Gain : < ia ABSLY
» O THD+N [7] Use High Perf & Sine Analy Dynamic Range -
» [J & Frequency Response Frequency
» [0 Signal to Noise Ratio - Filters IMD (DFD/MOD/SMPTE/CCIF)

» [ Crosstalk, One Channel Undriven High-pass: [Elliptic .] 20 Hz Input Sample Rate
» [ Interchannel Phase

Interchannel Phase
Add Measurement... Low-pass: | ADC passband v P—
u i evel and Gain
e i
v [ Post-Sequence Steps SR 224k (48 Kz SR) T Level Ratio

Add Step... Weighting: [None vl Maximum Output
[R):f:gutput EQ: [—F] E‘ :”Channels... oY OUt-put (CEA-M)
: Modulated Noise
« Device Under Test Noise (Q-peak per ITU-R BS.468-4)
Delay: 0.000s Noise (RMS)
PSR
Resistance (DCX)
Verify Connections Signal to Noise Ratio

SINAD

=

Figure 52 Launch THD+N Test
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8. To run THD+N test, configure the Input Level and Bandwidth as shown below. Click on the "Generator" button to
run the test. THD+N ratio will be displayed for both channels. THD+N ratio is typically displayed in Percentage (%).
To display the values in dB, select "dB" from the drop-down menu next to Unit on top of the display.

REH EE-BA B e -

I P Generator [l OFF I

» Generator

Waveform: [Sine

4

[] Levels Track Chl
Level DC Offset
- E > B g
Chil: -0.000 dBFS g 0.000D
=
(oW

<)

Frequency: 1.00000 kHz v

Channels:
T 7]
- Analyzer
High-pass Filter: [Signal Path v] C h 1
Low-pass Filter: [Signal Path v]
Weighting: [Signal Path vl
Notch Tuning Mode: [Measured Frequency v]

[ Advanced Settings... ]

Figure 53 THD+N Measurement Settings
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6.2.3 Measuring Dynamic Range for the CS43131

To measure dynamic range in the WISCE software, click File->Load and select
XTAL_In_ASP_Slave_PCM_Playback 48K_1v7.txt file from {WISCE_INSTALL FOLDER}/profiles/CS43131 to configure
CS43131 for audio playback in Slave Mode. Note that this method only works when measuring the CSP device. The QFN
device (with mono output) does not interface easily with the CDB-HDR-MEAS board.

6.2.3.1 Measuring Dynamic Range
The following steps show the procedure to measure dynamic range.

Place a jumper connecting the 600-Q load on J15.

Place a jumper connecting the 600-Q load on J4.

Connect a headphone cable between CSP-HPOUT(J1) and the input of the CDB-HDR-MEAS.

Power up the CDB-HDR-MEAS board with £15V and GND.

For each channel, connect a cable between the BNC jacks (Left Channel, Right Channel) and Balanced port on
Analog Inputs 1 and 2 on the APX.

agrwnE

v - ‘QQ'
9 -

ADVANCED DISITAL Lo
- Vo -

Figure 54 Dynamic Range Setup for CS43131
6. Configure APx and run Dynamic Range Measurement test as described in section 6.2.2.
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6.2.4 Measuring THD+N for the CS43131

To measure THD+N in the WISCE software, click File->Load and select
XTAL_In_ASP_Slave_PCM_Playback 48K_1v7.txt file from {WISCE_INSTALL FOLDER}/profiles/CS43131 to configure
CS43131 for audio playback in Slave Mode.

6.2.4.1 Measuring THD+N on CSP Device
The following steps show the procedure to measure THD+N.

1. Place a jumper connecting the 600-Q load on J15.

2. Place a jumper connecting the 600-Q load on J4.

3. Connect a headphone-RCA or headphone-BNC cable between CSP-HPOUT(J1) and the Balanced port on Analog
inputs 1 and 2 on the APX.

i sss .«

L)

g .

v
i a

N\
¥
' % COBAIH
RevAQ-017

/ ‘ .
.
T
‘,71‘7
: .

=P CIRRUS LOGIC
COB4 31

Figure 55 THD+N Measurement for CS43131 CSP
4. Configure APx and run THD+N Measurement test as described in section 6.2.2.
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6.2.4.2 Measuring THD+N on QFN Device
The following steps show the procedure to measure THD+N.

1. Place a jumper connecting the 600-Q load on J17.
2. Place a jumper connecting the 600-Q load on J31.
3. Connect a XLR cable between QFN-OUT(J60) and the Balanced XLR port on Analog input 1 on the APX.

Audio Precision

LOG OUTPUT 1 (e ANALOG INPUT

BALANCED —

DIGITAL SERE\L 1/0

==
—= CIRRUS LOGIC"
; CDB4 3131

Figure 56 THD+N Measurement for CS43131 QFN

4. Configure APx and run THD+N Measurement test as described in section 6.2.2.
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6.3 Measured Results

This section shows some measured dynamic range and THD+N results from the CDB43131K Kit.

6.3.1 Test Waveforms

All test waveforms were generated using the APx Waveform Generator Utility that can be found on the Audio Precision
website.

Table 11 Test Waveforms

Test Type Waveform Name Sample Rates Resolution Channels
THD+N Reference Level (0 dB) 44.1 kHz 24 bit 2
DNR Dynamic Range (1 kHz) 44.1 kHz 24 bit 2

6.3.2 THD+N Results

The table below lists measured THD+N results using the test waveforms under varying load and full-scale voltage
conditions.

Table 12 Measured THD+N Results

Output Load (RL) Full Scale Voltage (VRMS) Channel Datasheet Spec (Typical) Measured Result *

600 17 A -113dB -113.0dB

B -113.2dB

XLR -114.1dB

32 1.0 A -110dB -108.5dB

B -107.7 dB

XLR -111.8dB

16 0.5 A —100 dB -103.8 dB

B -103.5dB

XLR -108.8 dB

Notes:

1. Refer to the CS43131 data sheet for test conditions.

6.3.3 Dynamic Range Results

The table below lists measured DNR results using the test waveforms under varying load and full-scale voltage
conditions.

Table 13 Measured DNR Results

Output Load (RL) Full Scale Voltage (VRMS) Channel Datasheet Spec (Typical) Measured Result *

600 1.7 A 130 dB 130.5dB 2

B 130.4dB?

XLR 131.6 dB

32 1.0 A 125dB 122.5dB

B 122.4dB

XLR 126.8 dB

16 0.5 A 119 dB 116.5dB

B 116.5dB

XLR 120.9dB

Notes:

1. Refer to CS43131 data sheet for test conditions.
2. Tested with the CDB-HDR-MEAS Board.
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7 Revision History
Revision Changes
DB1 « Initial release
JUL '18
DB2 » Updated kit name to CDB43131K
SEP '18 » Updated status LED table
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Contacting Cirrus Logic Support
For all product questions and inquiries, contact a Cirrus Logic Sales Representative.
To find one nearest you, go to www.cirrus.com.

IMPORTANT NOTICE

The products and services of Cirrus Logic International (UK) Limited; Cirrus Logic, Inc.; and other companies in the Cirrus Logic group (collectively
either “Cirrus Logic” or “Cirrus”) are sold subject to Cirrus Logic’s terms and conditions of sale supplied at the time of order acknowledgment,
including those pertaining to warranty, indemnification, and limitation of liability. Software is provided pursuant to applicable license terms. Cirrus
Logic reserves the right to make changes to its products and specifications or to discontinue any product or service without notice. Customers should
therefore obtain the latest version of relevant information from Cirrus Logic to verify that the information is current and complete. Testing and other
quality control techniques are utilized to the extent Cirrus Logic deems necessary. Specific testing of all parameters of each device is not necessarily
performed. In order to minimize risks associated with customer applications, the customer must use adequate design and operating safeguards to
minimize inherent or procedural hazards. Cirrus Logic is not liable for applications assistance or customer product design. The customer is solely
responsible for its product design, including the specific manner in which it uses Cirrus Logic components, and certain uses or product designs may
require an intellectual property license from a third party. Features and operations described herein are for illustrative purposes only and do not
constitute a suggestion or instruction to adopt a particular product design or a particular mode of operation for a Cirrus Logic component.

CERTAIN APPLICATIONS USING SEMICONDUCTOR PRODUCTS MAY INVOLVE POTENTIAL RISKS OF DEATH, PERSONAL INJURY, OR
SEVERE PROPERTY OR ENVIRONMENTAL DAMAGE (“CRITICAL APPLICATIONS”). CIRRUS LOGIC PRODUCTS ARE NOT DESIGNED,
AUTHORIZED OR WARRANTED FOR USE IN PRODUCTS SURGICALLY IMPLANTED INTO THE BODY, AUTOMOTIVE SAFETY OR SECURITY
DEVICES, NUCLEAR SYSTEMS, LIFE SUPPORT PRODUCTS OR OTHER CRITICAL APPLICATIONS. INCLUSION OF CIRRUS LOGIC
PRODUCTS IN SUCH APPLICATIONS IS UNDERSTOOD TO BE FULLY AT THE CUSTOMER’S RISK AND CIRRUS LOGIC DISCLAIMS AND
MAKES NO WARRANTY, EXPRESS, STATUTORY OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR PARTICULAR PURPOSE, WITH REGARD TO ANY CIRRUS LOGIC PRODUCT THAT IS USED IN SUCH A MANNER. IF THE
CUSTOMER OR CUSTOMER’S CUSTOMER USES OR PERMITS THE USE OF CIRRUS LOGIC PRODUCTS IN CRITICAL APPLICATIONS,
CUSTOMER AGREES, BY SUCH USE, TO FULLY INDEMNIFY CIRRUS LOGIC, ITS OFFICERS, DIRECTORS, EMPLOYEES, DISTRIBUTORS
AND OTHER AGENTS FROM ANY AND ALL LIABILITY, INCLUDING ATTORNEYS’ FEES AND COSTS, THAT MAY RESULT FROM OR ARISE
IN CONNECTION WITH THESE USES.

This document is the property of Cirrus Logic, and you may not use this document in connection with any legal analysis concerning Cirrus Logic
products described herein. No license to any technology or intellectual property right of Cirrus Logic or any third party is granted herein, including but
not limited to any patent right, copyright, mask work right, or other intellectual property rights. Any provision or publication of any third party’s products
or services does not constitute Cirrus Logic’s approval, license, warranty or endorsement thereof. Cirrus Logic gives consent for copies to be made of
the information contained herein only for use within your organization with respect to Cirrus Logic integrated circuits or other products of Cirrus Logic,
and only if the reproduction is without alteration and is accompanied by all associated copyright, proprietary and other notices and conditions
(including this notice). This consent does not extend to other copying such as copying for general distribution, advertising or promotional purposes, or
for creating any work for resale. This document and its information is provided “AS 1S” without warranty of any kind (express or implied). All statutory
warranties and conditions are excluded to the fullest extent possible. No responsibility is assumed by Cirrus Logic for the use of information herein,
including use of this information as the basis for manufacture or sale of any items, or for infringement of patents or other rights of third parties. Cirrus
Logic, Cirrus, the Cirrus Logic logo design, WISCE, Halo Core, and SoundClear are among the trademarks of Cirrus Logic. Other brand and product
names may be trademarks or service marks of their respective owners.

Copyright © 2018 Cirrus Logic, Inc. and Cirrus Logic International Semiconductor Ltd. All rights reserved.

Windows is a registered trademark of Microsoft Corporation.
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